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New features

These are features that are
new to the Windows
version of Adminware that
were not in the Dos
version.

Adminware™ for Continuing Education is an all-encompassing database that meets the needs of
Continuing Education departments.

The database consists of several modules:

vV vV vV VvV VvV VYV

Student enrollment

Course offerings

Teachers

School facilities

Permanent Mailing List

coded Look-Up tables

System and User configuration (including security)

Access allows us to incorporate new and exciting features that were either not implemented or
available in DOs version of Adminware. Here is a sample:

>

vV vV vV VvV VvV VYV

e-mail button on student, teacher, mail list form. Takes e-mail address and loads Outlook
automatically.

students: one entry for life, unlimited courses per term, complete past history of courses.
fees: unlimited fee transactions per course.

courses: option to display all previous courses or specific term.

teachers: all previous courses taught available.

multiple forms (modules) open at the same time.

reporting: multiple criteria options available; print preview; reports can have images.
cut and paste between any other Windows application.
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Terminology Database
Table

Fields

Data types

the complete set of tables, forms, queries, reports, programming code.
an individual set of information, such as a Course list or a School list.

individual pieces of information for each table, such as Phone number, customer
number, etc.

Certain fields at certain times may be disabled — they cannot be modified = & - - |
based on the current conditions. You must wait until the field is enabled =
before the cursor can be placed in the field.

Fields that are “flat” and without any border are
either look-up fields from another table or
calculated fields (this is by design). Sunken fields ' User name [Robin Haris
can be edited.

lzerld HRH

We are aware of the most common data types for fields: Text, Numeric, String, etc.

Access has a data type called null. This is when the field contains nothing, not even a space.
A field that contains even a space (by hitting the space bar) contains something and is no
longer null. When doing queries, it is quite common to query on IsNull, that is, only find
those records where this field contains nothing.

Edit/Saved records

As soon as you begin typing in a
field in a record, that record is
locked and editing begins. The
icon in the left hand bar (called the J E
record selector) on the form changes 7 7 @
from a black triangle to a pencil. Stdld T sidid Stdld
As long as the pencil icon is
present, the data for this record . _ _
has not been saved — moving to First nar First niar First niar
another record, opening another

|E File Edt| ||E Al Edt| |/E Fle Edt

% B ||od

4B ||| 4 B

Lazt nam Last nanm Last nanm

. Addiezs Addrezs Addrezs
form, or clicking the Save button Fi - -
. igure 3 Figure 4 Figure 5
on the form will save the data. Saved record Edited record Locked record
Symhbol Meaning
3 Current record: This is the current record; the record
has heen saved as it appears.
F FPencil: You are editing this recaord; changes to the
record aren'tyet saved.
@ Locked record: This record is locked by another
user; you can't edit it (Microsoft Access database
oy,
* MHew record: This is a new record that vou can enter

infarmation in.
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‘Generic’ Access

Access is an extremely powerful program. To take advantage of its capabilities, we have developed
custom input forms, many of which are based on queries. The custom designed reports are based

on selection criteria input forms and queries.

However, there will rare occasions when we will need to work with Tools IM Help

the raw data. This will involve working with the various underlying =
Access objects — tables, queries, reports, and forms. i | @  1ac:Database
—— £ Switchboard =
Use the Window pull-down menu to gain access to this raw data. IT 3 Students i
The first menu option, ac : Database, gets us to the Access objects ~— | 4 Courses L
screen. —_— ”
& =]
The Access Objects are |[EEHLECE H= B
groupe(_j Into common Qpen & Design *51ew | e [
categorles:
- dh 1 AdminGry-ImportStdDe
» Tables Create query by using wizard gp 1 AdminGry-ImportTeack
> Queries dR ! AdminQry-AddCourseClassification @1 AdminQry-Maillist-City-
» Forms | Admanry—DeIeteAllCnurlse Admanry—thClty—Asch
. Reports %1 .ﬂ.dm!ner-DeIete.ﬂ.IIMeetmg A1 AdminGry-Teacher-City
> etc. # 1 AdmindQry-DeletesllStdDemo qryCaourseDef TermRpk
# 1 AdminGry-DeletedliTeacher qryCaourseEnr
C . . e Admindry-ImportacSchFac qryiZoursel abel
CIICkmg on the Ob]e?t k8 AdminQry-ImporkCiky B gryCourselist
n,ame at the left WI" k1 AdminQry-ImporkCourse gryi_rsached
dls_play those respectlve k1 AdminQry-ImporkCrsiMeeting B gryCrsstdCount
objects. Wb AdminQry-ImportMailist aryCrastdList
=l AdminCry-ImportSchool qrvFeeReconcPre
KN I

Caution:

Do not design and change any of the existing tables, forms, queries,
reports, etc. as they are essential to the proper working of the program.

Adminware takes no responsibility for any changes you make that
renders the program non-functional!
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Navigation

As with any Windows program, there is usually more than one way to accomplish a given task.
Moving throughout the Adminware is no different.

Following are various methods of moving from one module to another:
» via the Main Switchboard. This is the form (screen) that appears first when the program

is loaded. There are buttons available to each of the various main modules. From within
a given module there will be other buttons to move you to sub-modules.

» use the Window pull-down menu. The Window pull- 1. window Help

down menu (Alt-W) will list all of the currently open -

modules. Pressing the number of the desired module will & | g Lac: Database

move yo to that module. If the module you want isnot = & Switchboard N

yet open, choose 2 Switchboard and then select the ITQStudents i

button. 4 Courses m
» the Toolbar has icons to open/move you to the desired M =

module; Figure 9

Window pull-down menu

it i & 'a@E

Figure 10

Switchboard Courses Mail List Look-Up

Students Teachers Schools
‘Today’

» double-click on a student id, course id, or teacher id from any module to move you to that
module and display the corresponding record.

iz, Adminware - [Switchboard]
J File Edit Wew Insert Format Records Tools Window Help ;liljl
ot BiotiziZav(as i r iy eadEdreREAE
Term: 2002F
] L4 + L STt Student c
ConunumMgAiaucaAtion| s Courses
632 Go 71
River East School Division No. 9 s DR =
37 Cancel 5
fund
Students | Mail lisk | Refun
Hold
Courses | Schools |
Teachers |
Look-up Tables |
Mizcellaneous |
Exit |
Fd: view today's scheduled classes
shift-FS: show calendar
[Farm ew o

Figure 11 Main Switchboard
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Mouse Vs Keyboard Most people use the mouse in Windows applications to move around the screen and to choose
commands — that is the nature of a graphical-based interface. However, a database programis a
data-oriented application where the keyboard is used extensively to add and edit information. Much
effort has been made to provide keystroke options as often as possible.

Inany Windows application, anunderlined ESSLILLIRIGIILID)
letter indicates that a keystroke (Alt-letter) ||E3 Sl Edt View josert Formet Records Teds Windaw belp
will invoke that option/command. DR AEIEHIRA - R R

4 Sid1d 3524 Add student |

In the illustration to the right, pressing Alt-F Last name  [Haris

will invoke the File pull-gdowpn men%; but . I e

Alt-T will place the cursor in the Std 1d field! —
why take your hand off the keyboard, find
the mouse, move the mouse so the insertion
point is in the Std Id field, click the left mouse button, put your hand back on the keyboard, and
continue working?

First name |F|obin

Figure 12 Alt-letter selecting

With that said, there are many instances where the mouse is more efficient than using the keyboard.

Find Finding a specific record is an important part of working with, and editing, your data. There are
a number of options available to move through the records in a table.

» move one record at a time, either forward or backward. This will only be of benefit if the
data in the table is in a logical order pertaining to the type of editing you are doing. There
are two places on the form that you can move this way:

» viathe Toolbar H 4 F M M+
» via the record selector at the bottom of the form :
Figure 13
Toolbar record
Record: 14 4[] 1234 ¢ | o1 |v#] of 3308 selector

[First Previous Next

Figure 14 Last AddRecord]

Record selector (bottom of form)

» use Access’ Find feature (Ctrl-F) from most fields. This will search the current field for the
desired information, displaying one entry at a time. Youcannot use this feature in subforms
or in datasheet views as there is very limited information in these lists.

» Uuse a ‘Jump’ option to pop-up a matching list of records.

Field movement When moving through fields on a form, either adding a new entry or editing the existing entry, use
the Tab key to move to the next field and Shift-Tab to move back to the previous field.

Key Movement

Tab next field

Shift-Tab previous field
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Watch out for...

Find (Ctrl-F)

Editing text

Here are some known features and/or bugs that one should be aware of...

Access’ Find (Ctrl-F) command, like the Find feature in Microsoft’s other products, is really called
Find next. The key word here is next.

Access begins its find (search) starting with the next record, not the current record.

Consider the following:

» you are sitting in the student screen in the student id field on id# 1000.
» you do a Find (Ctrl-F)

» you search for student id 1000.

» you will receive the following message:

Adminware

@ Adrinvare finished searching the records, The search item was not Found,

This message is suggesting that Std I1d 1000 does not exist in the student table (even though
it does!). However, based on the Access Find next feature, Std 1d 1000 does not exist after the
current record (and it wouldn’t because each Std Id is unique).

Be cautious of selected text.

Text is selected when it is highlighted (ie. white on a =,
black background). Just like in any Windows application
(such as Word), if text is selected and you begin typing,
the entire selected text will be replaced with the new text. Be cautious of this but also, use it to your

advantage!

ddresz V70 Inkater Bl

If you want to delete a lot of text, select it and then press the delete key! Done.
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Pull-down menus It has been mentioned before that using the keyboard can be quicker than the mouse in many
instances. If you get in the habit of using the keyboard to select fields, buttons, and pull-down
menu options, you may fall into the following problem...

If you press the Alt key, change your mind, and do not select any other key, you have actually
activated the pull-down menu!

Here is the generic Access pull-down menu:

& Adminware - [Students]

J File Edit %ew Insert Format Records Tools Window Help

Here it is again when the Alt key is pressed once and then released:

& Adminware - [Students]
J Eile|§|:|it Wiew Insert Format Records Tools Window  Help

Notice the File menu option — it has been selected, as indicated by the raising of the word!

If you now press a letter associated with one of the pull-down menus (say T), you will pull-down
that menu option — even though you might be expecting the T to be typed into the current field
you are editing.

To de-activate the pull-down menu you can:

»  press the Esc once (if you have a menu pulled-down you will need to press Esc twice —
once to get rid of the menu and a second time to leave the pull-down menus altogether).

Or

» click the mouse somewhere on the screen.

Dates Date fields in the program are displayed as dd-mmm-yy.

When entering dates, you can simply enter ‘Jun 19'. Access will automatically convert this to
19-Jun-02 (or whatever the current year is).

»  Atwo-digit year is converted to four digits, where less than 30 becomes 20nn and greater
than 29 becomes 19nn.

» To enter today’s date, press Ctrl-;
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Where am 1?

Take at a look at the following image. Where is the cursor?

g Adminware - [Students]

J File Edit Wew Insert Format Records Tools Window Help

&5 =m0 2228 A% K | ¥ [mQEHDeDEQ D)

' g stucens | s =T |
Std 1d 3928 Add student Phone 204 .| |586-3147
3528 | F
Last name  [Harris I Business  [306 | ESB-322B Ext [4738
First marne |Fh:ubin ) Cell phane I vI I Report |
Address |??D Inkster Blvd Birth date I
City |ST. PIERRE | Prov |MB | Ernail |rharris@adminware.ca E-mail |
Mowe I

Pl R2w/ OL5 Lt St IE =l Added 17-0ct-02 | Modified | 13-Mov-02

Dielata I

School: Kildonan Eask Crs 140,19

Creld  [FADS Shatus IG .I Enrall | Start: Wed, Sep 25/02 (F) GST § 9.81

Time: F:00-10:00 Duz ¢ 150.00
ACCESS 2000: BASIC CONCEPTS Hours: 3fsession Weeks: & Book £ 0.00

BillTa | Fees

How IM 'I SrcIF 'I FeeTppeI 'I
b ark. I_ WF'MI Mergel

Comment |First student add!

PayDate |PayCa|PayTy Amount| Retho |
17-0ct02 [T WS 12500 63658

*|v

Entolled  17-Cct-02 Modified

Record: 14 < || 1 | vnv] of 1

Allowable Go  Wait Cancel Refund  Hold

Crzld |:| 14 G 10 Tuition owing for this course: $25.00 Tar Fit |
Record: I1| 1 || 3908k |>| |>*| of 3905
[Farm Yiew | S )

Answer: notice the Current (2002F) courses tab (left side, half way down) — there is a dotted border
around the tab control.

There are many fields, menus, buttons, tabs, sub-forms, lists, etc. found on any one form in Access.
When you press the Tab key to move from one field to the next you may also need to pass ‘over’
a tabbed control or button. As you do so, it may appear as though you have lost the cursor.

Here are some examples of what the cursor may look like as you move about the screen:

End of field (blinking)

Datasheet with entire

Pull-down menu
activated

Tabbed control (dotted
border around text)

Button (dotted border

field selected around text)

Ext [473

Cr=id

........................ et Fomat |Re

E

D
et

Tip:

In many cases, don’t worry about where you are, but rather where you would like to be. Simply click
the mouse where you want to go or select a button or field by pressing the Alt-letter option.
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